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BIM authoring software such as Vectorworks has 
allowed architects and others within the AEC 
industry to create complex, data-rich 3D models 
to explore and document design. This new 
technology also means new ways to share 
information among all consultants on a project. 
It becomes essential to establish an agreed upon 
method and file format for exchange between 
the different disciplines on a team. In some 
cases, a traditional 2D, line drawing exchange 
such as a PDF or DWG, is needed to support 
those who have not entered the 3D realm. Other 
times, exchange of only geometry may be 
necessary for clash detection and as a 
“background” for referencing in the form a 3D 
DWG. However, if the file exchange needs to 
support Building Information Models and the 
sharing of geometry and data, then the IFC file 
format should be considered.  
 

What is IFC?  

IFC, or Industry Foundation Classes, is a 
standardized open source file format that is 
optimized for building information modeling.  
Much like PDF or HTML, the specification for the 
code is open-source and freely available to the 
public for use and for developers to create their 
own tools to handle the data format.  

This means that all software vendors have equal 
access to the specifications and therefore, can 
create the necessary import and export 
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technology.  No single vendor controls this format 
or makes money from licensing this technology. 

The most important thing to remember is that IFC 
encodes both geometry and data. Additionally, 
there are certain aspects of IFC that make it ideal 
for an open BIM exchange. These include: 

Geometry – IFC geometry is robust and includes 
vectors, solids, surfaces, and so on.  

Data – IFC supports three main aspects of the data 
in a BIM model: 

Semantics – the meaning or identity of a 
collection of geometry related to building 
objects, such as a window within a wall. 

Relationships – speaks to how the 
geometry is related to each other such as 
a door inserted into a wall 

Properties – definition of materials that 
includes data such as cost or model 
number 

Central to the concept of IFC is the idea of 
“semantic objects.” When the geometry of a 
model is identified as a building element and 
has “meaning” within the context of 
construction, it becomes a semantic object for 
a building information model. For this reason, 
IFC becomes an ideal file format to share a 3D 
model with associated data for the BIM process. 

IFC is an international open standard, 
developed and maintained by buildingSMART 
International, for building models and data that 
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permits information to be shared and 
maintained throughout the life cycle of a 
construction project: design, analysis, 
specification, fabrication, construction, and 
occupancy.   

The capabilities and usage for IFC standards are 
evolving. Some examples of the use of IFC 
include: 

• Collaborative design, where an architect 
exports an architectural model to a 
structural engineer for analysis and design, 
and then imports the structural model, in an 
IFC format, for coordination purposes  

• Energy performance simulation and analysis of 
a building envelope and systems 

• Automated analysis of code compliance 

• Space planning and space inventory analysis 

 

Why is IFC important? 

Being an open source file format, IFC supports a 
more collaborative BIM process allowing each 
project stakeholder to make meaningful 
contributions to the project using the best-suited 
tool for the job. Every member of the project team 
has different needs and different end-goals.  That 
means that they will be using the BIM model for 
different purposes and to gather or generate 
different or unique data. There is no single 
application that can fulfill all these different uses 
and needs.  If each project member is able to use 
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the tool of their choice, then they are able to do 
their part in an efficient, effective, and executable 
manner. All the while creating a model that can 
be shared and effectively used throughout the BIM 
process.  

Some other benefits of using the IFC file format 
include: ownership of your project contribution 
and the ability to be independent of limitations of 
versioning found in proprietary file formats, 
portability and accessibility of project information 
from different applications, and the extensibility of 
an IFC file.  

What does IFC mean for Vectorworks users? 

For Vectorworks users, IFC is the file format 
needed to share both the geometry and data 
within their BIM model with the project owner, 
the project consultants, construction manager, 
facilities manager, and other project team 
members who are not using Vectorworks.  

Vectorworks supports Building Information 
Model (BIM) interoperability using the Industry 
Foundation Classes (IFC) file format. 
Vectorworks currently supports IFC versions 
2x2 and 2x3 and has been certified by 
buildingSMART International for the export of 
models based on the IFC2x3 Coordination 
View 2.0 – Architecture model view 
definition, as well as the import of any IFC2x3 
Coordination View 2.0 model. This manual 
assumes the use of at least Vectorworks 
Architect. 
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Vectorworks Architect provides you with the 
necessary tools to create a complete and useful 
IFC model. Nearly all default content within 
Vectorworks Architect is tagged for IFC export 
requiring minimum effort by the user.  

With the IFC Data command, you can assign IFC 
object types and properties to custom-built 
geometry so applications that “read” IFC files can 
identify these objects. 

Additionally, when IFC files are imported into 
Vectorworks, the IFC objects within the file are 
brought in as a particular and flexible kind of 
plug-in object called an “IFC Entity.”  An IFC 
Entity is created because the properties of 
objects created in other programs cannot easily 
be matched to all the corresponding 
Vectorworks object properties and controlling 
parameters. For more detailed information on the 
export and import of IFC files, see the Export/Import 
Section of this guide.  

The semantic definition of an IFC Entity - 
IfcColumn, IfcWall or IfcWindow, for example, 
is maintained and displayed. Like a group or 
symbol, an IFC Entity can contain a collection 
of geometry, and, like a plug-in object, it can 
be inserted into walls and has sets of data and 
properties attached. With this generalized 
import capability, Vectorworks can import any 
kind of object supported by the IFC standard. 

Space objects are somewhat unique in that 
when an IFC file containing space objects 

7

created in another program is imported into 
Vectorworks, the IfcSpace objects are correctly 
translated into corresponding Vectorworks 
Space objects.   

 

IFC Objects and Property Sets in Vectorworks 

An IFC object is a building object that has been 
defined by both its occurrence and type. This 
means that a building object created in 
Vectorworks, either with the default objects or a 
user-created object, can be tagged as an IFC 
object to define its semantics, properties, and its 
relationship to other building objects.  

When an object is tagged for IFC, it is assigned 
an IFC Property Definition known as a Property 
Set or PSet. An IFC Property Definition captures 
an objects dynamically extensible property set, 
or associative data. This set of properties is 
attached to the object’s occurrence and type. 
More than one property set can be associated 
with an IFC object, including custom property 
sets that are defined by the Vectorworks user. 
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IFC Object Tags for Standard Objects  

Most intelligent objects supplied with Vectorworks Architect 
through the default building tools or symbol libraries are designated 
with their appropriate IFC tag by default. Blow is a list of major 
building components and their corresponding IFC object tags.  

Base Cabinet = IfcFurnishingElement 

Bath-Shower = IfcFlowTerminal 

Ceiling Grid = IfcCovering 

Clothes Rod = IfcFurnishingElement 

Column = IfcColumn 

Column Wrap (Architectural column) = IfcCovering 

Comm Device = IfcDistributionFlowElement 

Compartment Sink = IfcFlowTerminal  

Counter Top = IfcFurnishingElement 

Curtain Wall (Straight & Curved) = IfcCurtainWall 

Curtain Wall Frames = ifcMember 

Curtain Wall Panels = IfcPlate  

Desk = IfcFurnishingElement 

Door = IfcDoor 

Drilled Footing = IfcFooting 

Simple Elevator = IfcTransportElement 

Escalator = IfcTransportElement 

Fireplace = IfcDistributionFlowElement 

Floor = IfcSlab 

Framing Member = IfcMember or IfcBeam 
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Grab Bars = IfcRailing 

Guardrail (Curved & Straight) = IfcRailing  

Handrail (Curved & Straight) = IfcRailing 

HVAC Damper = IfcDistributionFlowElement  

HVAC Diffuser = IfcDistributionFlowElement 

HVAC Elbow Duct = IfcDistributionFlowElement  

HVAC Flex Duct = IfcDistributionFlowElement 

HVAC Outlet = IfcDistributionFlowElement  

HVAC Splitter = IfcDistributionFlowElement 

HVAC Straight Duct = IfcDistributionFlowElement  

HVAC Transition = IfcDistributionFlowElement 

HVAC Vertical Duct = IfcDistributionFlowElement  

HVAC Vertical Elbow = IfcDistributionFlowElement 

Incandescent Fixture = IfcDistributionFlowElement  

Landscape Wall (including Arc and Bezier) = IfcWall 

Massing Model (on layer mapped to site) = IfcBuilding  

Mullion = IfcMember 

Parking Spaces = IfcSpace  

Pilaster = IfcColumn 

Pillar = IfcColumn  

Piping Run = IfcDistributionFlowElement 

Plant = IfcBuildingElementProxy  

Ramp = IfcRamp 

Receptacle = IfcDistributionFlowElement  
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Roadway (all types) = IfcTransportElement 

Roof = IfcRoof (containing instances of IfcSlab)  

Roof Face = IfcSlab 

Seating Layout = IfcFurnishingElement  

Round Wall = IfcWall or IfcWallStandardCase 

Wall = IfcWall or IfcWallStandardCase  

Site Model = IfcSite 

Shelving Unit = IfcFurnishingElement  

Slab = IfcSlab 

Space = IfcSpace  

Stair = IfcStair 

Switch = IfcDistributionFlowElement  

Table = IfcFurnishingElement 

Tables and Chairs = IfcFurnishingElement  

Toilet Fixture = IfcFlowTerminal 

Utility Cabinet = IfcFurnishing Element  

Wall Cabinet = IfcFurnishingElement 

Window = IfcWindow 

Workstation Counter = IfcFurnishingElement 

Workstation Overhead = IfcFurnishingElement  

Workstation Panel = IfcFurnishingElement 

Workstation Pedestal = IfcFurnishingElement  
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Additionally, as of Vectorworks version 2010, nearly all symbols 
in the following symbol libraries have appropriate IFC2x3 object 
types pre-attached, so that symbols used from these libraries 
properly export to IFC2x3: 
 

Architect Sampler.vwx  

Equip-Office Equipment.vwx 

Equip-Residential Appliances AGA Ranges.vwx  

Equip-Residential Appliances SubZero USA.vwx

Equip-Residential Appliances Wolf USA.vwx  

Equip-Residential Appliances-Audio Video.vwx

Equip-Residential Appliances-Imp.vwx 

Equip-Restaurant Equipment-Imp.vwx 

Fixtures-Imp.vwx

Furniture-Furnishings and Scenic 
Elements.vwx  

Furniture-HMI-Modern Classics.vwx

Furniture-Knoll.vwx 

Furniture-Misc-Imperial.vwx 

Furniture-Misc-Metric.vwx 

Furniture-Office.vwx 

Furniture-Residential.vwx  

Furniture-Systems HMI-Typicals.vwx 
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Figure 1 – IFC Object Type and Property Set for default Vectorworks Door PIO. 
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Furniture-Systems-Imp.vwx  

Furniture-Systems-Metric.vwx 

Openings-Windows Velux Skylights.vwx  

Electrical-Lighting Fixtures Int & Ext.vwx

Electrical-Lighting-Imp.vwx 

Electrical-Panels-Imp.vwx 

Electrical-Panels-Metric.vwx 

Electrical-Power Devices-Metric.vwx 

HVAC-Equipment-Imp.vwx  

Sanitary-Fixtures.vwx 

Sanitary-Kohler Baths.vwx  

Sanitary-Kohler Bidets.vwx 

Sanitary-Kohler Faucets Bathtub & 
Shower.vwx  

Sanitary-Kohler Faucets Kitchen.vwx

Sanitary-Kohler Faucets Lavatory & 
Bidet.vwx  

Sanitary-Kohler Lavatory Sinks 01.vwx

Sanitary-Kohler Lavatory Sinks 02.vwx  

Sanitary-Kohler Showers.vwx 

Sanitary-Kohler Sinks.vwx 

Sanitary-Kohler Toilets.vwx

Sanitary-Kohler Whirlpools.vwx 
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When exporting objects such as doors, 
geometric information (width, height, opening 
direction, etc.) is automatically exported, as this 
is based on the “physical” geometry of the 
object. This way model checking applications 
like Solibri can find collisions with other 
geometry such as columns, low ceilings or MEP 
elements like air pipes.  When these objects 
have a default IFC tag they are also assigned an 
appropriate default property set associated with 
the IFC object. For example, a default door 
object is tagged as an IfcDoor and has the 
IfcDoor Pset associated with it (see Figure 1).  
Other Psets can be assigned to the object as 
needed.  

An important thing to note is that behavior or 
transference of information from a default 
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object’s settings may not always translate to the 
appropriate fields of the default Pset that is 
attached to the object. For example, an “out of 
the box” wall style having data definitions such 
as an R-value or a fire rating will translate to the 
appropriate IFC Property Set field 
(IfcWallCommon) automatically. On the other 
hand, these settings for a door object will not. 
The user will have to assign the appropriate Pset 
and fill in the fields.  

This guide will cover the behavior of some 
default objects in order to help you understand 
the behavior of the IFC data dialog box and the 
IFC export. Not all objects will be covered in 
detail. The hope is that with a better 
understanding of the IFC export behavior; the 
user will be able to troubleshoot any problems 
that arise due to missing data and/or geometry.  
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Figure 2 – Object Information Palette pull-down 
menu within the “shape” pane. 

Figure 3 – “Select IFC Entity” dialog box. 
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As mentioned before, when a Vectorworks 
project is exported as an IFC file, Vectorworks 
default building objects and the identified 
default library symbols that are pre-assigned 
IFC data, will be exported as IFC objects. 
However, custom-made objects are not 
exported unless they receive IFC assignments 
prior to export. IFC assignments to these objects 
can be done with the “IFC Data” command. 
Assigning IFC data to an object does not alter 
it in any visible way within Vectorworks. The 
object can still be edited with standard 
Vectorworks tools and commands.  

 

To assign IFC data: 

1. Select the object, group, or symbol 
instance (symbols that have been placed 
in the drawing) for assignment of IFC 
data. More than one item can be 
selected at one time. 

2. Select the menu AEC > IFC Data  

NOTE: Alternatively, you can access the IFC 
Data Dialog by pressing the IFC button 
found at the bottom left of the Object 
Information Palette. If you do not see the 
IFC button, go to the pull-down menu at the 
top right of the OIP and select “Show IFC 
Data” at the bottom of the menu (Figure 2). 

 

The “Select IFC Entity” dialog box opens, listing 
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available IFC object types (Figure 3). Here you 
select the IFC Object type to assign to the 
building object. Most entities supported by 
Vectorworks for export can be found in the 
“Simple List.”  Refer to the “IFC Object Tags for 
Standard Objects” section to use as a guide for 
tagging custom made objects.  

3. Select the IFC object type and click OK. The 
IFC Data dialog box opens (Figure 4). Under 
“Object Properties,” select the Property Set 
to assign to the IFC object by adding a check 
mark under the “Use” column. You can 
select multiple Property Sets. If you are 
attaching a custom property set, select the 
“Manage Custom Property Sets…” button 
(see the Custom Property Sets section for 
more information). 

 

To enter the desired values for the properties of 
the selected Data Set, use the second window to 
select the property and the “String value” field 
(see Figure 4).  

For more detailed information regarding the 
available fields in the IFC Data Dialog, visit 
Vectorworks 2016 Help online.   
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Figure 4 – “IFC Data” dialog box. 

Figure 5 – Option to attach IFC data to a single 
instance of a symbol or all instances. 

Figure 6 – Dialog that appears when attaching IFC 
data to a symbol via the Resource Browser. 
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4. Click OK to assign the IFC data to the 
object. The Object Info palette will now 
display the selected IFC object (IFC 
value type and the object name, if any) 
when Show IFC Data is enabled on the 
palette. Objects like walls and slabs, with 
default IFC data assigned, display with 
<Default> to indicate that the default 
IFC data has not been modified. 

 

NOTE: When attaching data to a symbol 
there is the option to either attach the data 
to a specific instance of the symbol, or to 
the symbol definition. When applying IFC 
data to the symbol instance, you will see the 
following dialog: (Figure 5). If you select 
“Yes,” the IFC data will be attached to all 
current instances of the symbol as well as 
the symbol definition. This means that any 
future placement of the symbol will include 
the data as well. Select “No” if the IFC data 
is to be applied only to the selected instance 
of the symbol. 

To attach IFC data to a symbol definition 
through the Resource Browser, select the 
symbol definition in the Resource Browser, 
right-click and select IFC Data from the 
menu. After attaching the data, you will see 
the following dialog: (Figure 6). This 
attaches the IFC data to future symbol 
placements, and to any current instances 
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that do not have IFC data already attached 
to them. This option is best for making a 
“universal” change to the symbols through 
one operation.  
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To View and Edit IFC Data  

Figure 7 – IFC Data button located at the bottom left 
of the OIP. 
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The data attached to Vectorworks objects or 
IFC entities, whether created in Vectorworks or
imported from an IFC file, can be viewed and 
edited with the “IFC Data” command or from 
the IFC button in the Object Information 
Palette.  

To access IFC data: 

Select the IFC entity or Vectorworks object.  

NOTE: Multiple items can be selected. 

Select AEC > IFC Data  

Alternatively, click IFC Data from the Object Info 
palette (see Figure 7).  

NOTE: When multiple items have been 
selected, edits apply to all eligible objects in 
the selection. 

When the items to be edited have been 
specified, the IFC Data dialog box opens. 
View or edit the IFC data as described in 
“Assigning IFC Data to Objects” above. 

If an IFC entity was selected, the IFC Data 
dialog box displays the data attached to the 
entity as described in “Assigning IFC Data to 
Objects.”   

If a Vectorworks default building object was
selected, the IFC Data dialog box displays the 
corresponding IFC Object type.  

If a group contains multiple objects with 
differing IFC object types, the IFC tag assigned 
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to the group will not be assigned to the 
individual objects. That is, the objects within 
the group will retain their respective IFC tags.  

NOTE: If a symbol contains multiple objects 
with different IFC object types, a property set 
cannot be set to the symbol definition or 
symbol instance itself. Instead the objects 
within the symbol should be grouped and the 
appropriate PSet is then attached to the group 
within the symbol 
 
 
 
 
 
 
 

 

 

 

 

 

 

 

NOTE: If the IFC tag seen at the bottom of the 
Object Information Palette is preceded by 
“Default,” it simply means the default IFC data on 
this object has not been modified.  
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Assigning IFC Data to Space 
Zones  

Figure 9 – Assigning Space Zones through the OIP. 

Figure 8 – Assigning Space Zones through the Space settings dialog. 
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Most Vectorworks space information (type of use, 
etc.) is automatically written to the corresponding 
data fields of the IFC PSet. However, space areas, 
or zones, are a special case and are addressed 
here. 
A zone is a collection or group of spaces. IFC 
Zones are different from IFC Spaces insomuch 
that an IFC Zone cannot exist without an IFC 
Space. However, an IFC Space does not need to 
be associated with a zone. Space zones have 
many purposes such as defining programmatic 
use or a fire compartment or area of refuge.  
 

The “IFC Zones” command attaches IFC data to 
the specified zones in the current file. This means 
that zones must already exist in the file. Zones 
are initially created when they are assigned to a 
space object. This can either be done from the 
Occupancy pane of the Space Settings dialog box 
(Figure 8) or from the Object Information Palette 
(Figure 9).  

To attach IFC data to zones in the file: 

Select AEC > IFC Zones  

The IFC Zones dialog box opens. 

  

Zones in use in the file are listed above the 
divider line; available IFC zones are listed 
below the divider. Select a zone and click 
OK.  

NOTE: Only one zone can be selected at a 
time. 
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The IFC Data dialog box opens. The object 
type is automatically set to ifcZone, and the 
property Name value set to the zone name.  

Click OK to attach the IFC data to the zone. 
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Custom Property Sets  

Figure 10 – “Field Name” and 
“Type” definitions of a “record 
format” in Vectorworks. 

Figure 11 – IFC Value Types paired with record 
format fields. 
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When to Use Custom IFC Property Sets 

Property sets (or Pset) are used to assign groups 
of data fields, or properties, to IFC objects.
Property sets can be very specific to an IFC 
object, such as Pset_WallCommon to IfcWall, 
or they can be more general and applied to any 
IFC object, such as 
Pset_ManufacturerTypeInformation. The 
naming convention Pset_Xxx also applies to 
these property sets. 

Because IFC is extensible, any user-defined 
data can be assigned to an IFC object, even if it 
is not in the predefined list of pSets in the IFC 
Data dialog box.  These are called “custom 
property sets.” Custom property sets need to 
follow technical encoding conventions. They 
must have unique and allowable names. This 
means that the names cannot duplicate 
specified property set names or begin with 
“Pset_”. 

Custom property sets are captured and 
exchanged in the IFC format through 
Vectorworks’ record formats.  

 

Creating IFC-Compatible Record Formats  

To use a custom property set, you must first 
create a record format to define the data to be 
captured and exchanged in IFC format. To 
learn how to create a custom record format, please 
visit Vectorworks 2016 Help online.  
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The record format name defines the name of 
the custom property set. Therefore record 
formats designated for IFC export should either 
be named with a “VwPset_” or “ePset_” prefix. 
This will give the record the necessary unique 
name. Record format names are case sensitive, 
and cannot contain blank spaces. If necessary, 
use an underscore. For example, a record 
format can be named
“ePset_MyDataExchange.” 

As with any custom record, the record format 
can consist of any number of fields, 
designated by a “Field Name” and a “Field 
Type” (see Figure 10).  However, in order to 
be compatible with IFC standards, each field 
created must be paired with a second field 
that identifies an IFC Value Type (see Figure 
11). These pairs must have the same “Field 
Type.” These pairs cannot be separated, 
meaning that they must be in sequential order. 
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For example, the Field Name “Item 
Number” with a “Text” type, is 
followed by the Field Name “IfcLabel,” 
also with a “Text” type. The “IfcLabel” 
field indicates the kind of value type 
being used; in this case, it is a simple 
text ID string (Figure 11). 

 
When creating record format fields, a 
default value can be specified. The 
default values are optional, except for 
number fields, which require at least a 
zero value to be entered. This will be true 
for the corresponding IFC Value Types as 
well. 

Deciding which IFC value type and 
record format field type to use depends 
on the kind of information being 
captured by the field, such as a simple 
number or a measurement. In
Vectorworks, allowable types include 
Integer, Boolean, Text, or Number. The 
“Field Name” identifying an IFC value 
type should be based on the IFC 
specification for the different defined 
types, as shown in the following list. 
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IFC Value Types Vectorworks Record Format Field Type and Description 

IfcSimpleValue These are the most common and cover most user cases 

IfcInteger Integer: a simple whole number ranging from -32,7568 to 
32,767 

IfcReal Number: General or Decimal 

IfcBoolean Boolean: also known as TRUE or FALSE 

IfcLogical Boolean: similar to Boolean, but can include a value of
“UNKNOWN” 

IfcIdentifier Text: a simple text ID string, usually a mix of alphanumeric
characters and symbols 

IfcLabel Text: a simple text name string, usually a mix of alphanumeric
characters 

IfcText Text: a descriptive text field string of up to 255 characters 

IfcMeasureValue A complete list can be found in the IFC2x3 TC1 specification 

IfcAreaMeasure Number: Dimension Area 

IfcLengthMeasure Number: Dimension 

IfcMassMeasure Number: General or Decimal 

IfcThermodynamicTemperatureMeasure Number: General or Decimal 

IfcTimeMeasure Integer or Number: General 

IfcVolumeMeasure Number: Dimension Volume 

IfcDerivedMeasureValue A complete list can be found in the IFC2x3 TC1 specification 

IfcEnergyMeasure Number: General or Decimal 

IfcIlluminanceMeasure Number: General or Decimal 

IfcPowerMeasure Number: General or Decimal 

IfcThermalTransmittanceMeasure Number: General or Decimal 

IfcTimeStamp Integer or Number: General 

IfcLuminousIntensityDistributionMeasure Number: General or Decimal 
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When all field data pairs have been completed, 
click OK to create the record format (Figure 12). 
 

The record format appears in the Resource 
Browser, under the Record Format category. 
Like any resource, it can be shared between 
files using the export or import functionality 
of the Resource Browser. This is especially 
useful for custom PSets that will be used 
repeatedly for multiple projects. 
 
NOTE: The custom record format created does 
not need to be attached to the object in order to 
get a successful export of an IFC custom Pset. 
Instead, the custom record will be converted to 
an IFC Custom Property Set. For this reason, any 
IFC data that is attached to an object by way of 
the record format in the OIP will not be 
reflected in the IFC custom Pset. Data must be 
entered in the “IFC Data” dialog.  

CAUTION: If the record format created for 
the custom property set is deleted, the 
Custom PSet and all associated data will be 
deleted as well! It is recommended to not 
delete any record formats within a file. Be 
watchful of this when conducting a “purge 
objects” command.  
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Converting a Record Format to an IFC Custom 
Property Set    

Once the record format has been created, it is 
converted to an IFC Property Set and attached 
to an object, group, symbol definition, or 
symbol instance. 

To assign the custom IFC data: 

Select the object, group, or symbol for 
assignment of IFC data. 

Through the “Select IFC Entity” dialog box, 
select the IFC object type as described in 
“Assigning IFC Data to Objects” 

Click OK. 

The IFC Data dialog box opens. 

Click “Manage Custom Property Sets.” 

The Manage Custom Property Sets dialog 
box opens (Figure 13). 
Click in the Use column to include a record 
format. Selected record formats display with a 
check mark. You can select multiple record 
formats if they are present in the document.  

Click OK to return to the IFC Data dialog box 
(Figure 14). 

The selected custom record formats are 
listed as data sets in the IFC Entities/Psets 
list under “Object Properties.” 

Figure 12 – IFC Custom Property Set saved as a 
resource. 

Figure 13 – Selecting your custom PSet from the 
“Manage Custom Property Sets” dialog. 
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Figure 14 – IFC Data dialog with a Custom Property 
Set selected. 
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NOTE: If there are any errors in the naming, 
formatting, or pairing of any field in the record 
format, the custom property set does not 
appear in the IFC Entities/Pset list. Internal 
checks ensure the integrity of the data and 
automatically reject any errors. Correct the 
errors by editing the record format from the 
Resource Browser, and try again. 

Select the custom Pset and click in the Use 
column. A check mark indicates that the 
Pset is enabled and attached to the object. 

Select the custom Pset properties and assign 
values to the selected properties through the 
“String value for selected property” field 
(Figure 14).  

It is important to remember that any values 
added to the object via the data pane in the OIP 
for this custom record, will not carry through to 
the IFC Data dialog box. They have to be 
entered in the IFC Data dialog directly. 

Click OK to assign the IFC data to the object. 

The IFC data can be reviewed or edited by 
clicking IFC Data from the Object Info palette of 
a selected IFC object or entity, or by selecting 
the object or entity and selecting AEC > IFC 
Data.  

 

Because the custom property set is based on a 
record format it can be saved and imported to 
a different project for repurposing. To use a 
custom property set in another file or project, 
export the record format to another file and 
repeat the “manage custom property sets” 
process. 
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Proxy Elements  

The “proxy element” tag is reserved for model 
elements that do not have a semantic definition 
in the current IFC release. 
IfcBuildingElementProxy should be used to 
export special types of building elements that do 
not have a defined meaning for the element 
type. This means any object that does not fit any 
of the IFC semantic types found in the “Select 
IFC Entity” dialog box’s full list, it should be 
tagged as a proxy element. This will include any 
site elements that are incorporated in the model 
that may not have an IFC type equivalent.  

Proxy elements have generic property sets 
associated with them that include basic 
information such as object name, description, 
and object type (see Figure 15).   

 

Special Cases 

Stairs 

When using the Stair Tool to create stair objects, 
it is advisable to not mirror a stair object when 
creating additional stair elements.  The best 
course is to duplicate the stair and then enter the 
stair object’s dialog and change the 
“handedness” rather than using the mirror 
command. 

You may find that other geometry within 
symbols will display the same type of behavior. 
If so, place the symbol again without using the 
mirror tool.  

PROXY ELEMENTS AND 
OTHER SPECIAL CASES  
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Column Grid 

A column grid can be exported from 
Vectorworks by using 2D linework as the grid 
instead of the default “Grid Bubble” tool found 
in the “Dims/Notes” palette.  Use lines, arcs or 
circles to draw your grid. Each line of the grid 
must be individually tagged with IFC data by 
selecting IfcGridAxis from the list in the IFC 
Entity dialog box.   

Lines drawn for the vertical grid need a tag 
prefix of “V” and lines drawn for the horizontal 
grid need a tag prefix of “U.” 

For a third part of the grid that may include 
column lines at an angle the prefix “W” will be 
used. This prefix is reserved for only if you have 
a 3-grid axis. The IFC Grid can only support 
these 3 axes and nothing more. If necessary, 
you may need to create a “primary grid” and a 
“secondary grid.” 

For example:  

1. For lines drawn vertically, select a line, Select 
AEC > IFC data, click on the IfcGridAxis 
selection,  

2. Under “Object Properties” select the 
IfcGridAxis Pset to see the properties below.  

3. Choose AxisTag, enter the prefix “V” and the 
letter of the grid in the field for “String Value 
for Selected Property” (Figure 16). Click OK.   

Figure 15 – Basic property set of IFC Proxy Elements. 

Figure 16 – String Value for IFC Grid Axis. 
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4. Select the next grid line and repeat.  Use the 
prefix “U” for horizontally drawn grid lines. 
Use the prefix “W” for any angled axes or 
other, tertiary types of axes.  

5. Once all the axes are labeled as IfcGridAxis, 
group all of the lines, arcs, or circles together. 

6. Select the group, select AEC > IFC data, and 
click on IfcGrid to attach the IfcGrid tag to the 
group. 

NOTE: You can setup a name for the grid in 
cases where multiple grid groups exist. 

To create a “secondary grid,” follow the same 
steps, but create a separate group with the same, 
IfcGrid tag.  
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HOW TO SHARE AND USE 
YOUR IFC MODEL  

1

Exporting 

Generally, Vectorworks files are exported as 
entire projects (sites with buildings consisting of 
stories), to be exchanged or analyzed with 
other IFC-compatible applications. When you 
use the “Export IFC Project” command, you 
assign design layers to building stories. For a 
project initially set up with Vectorworks’ story 
organization, this assignment, called “layer 
mapping”, is done automatically. This means 
that the layers assigned to the building stories 
are automatically included in the Mapped 
Layers list and are mapped to an appropriately 
named IFC Story. Mapping can also be 
controlled manually, letting you override or edit 
the automated process. The manual process is also 
used if you have chosen to not use Vectorworks’ 
story organization. Keep in mind that when the 
layers are mapped manually, the last mapping 
settings are retained by Vectorworks. You will only 
need to map layers again if any new layers are 
added. 

The following guidelines may be useful when 
preparing your model for export: 

Set up the project with stories from 
the beginning. Though not 
completely necessary, it does 
automate part of the export process. 

Take care to set up the elevation values of 
layers correctly, and verify that all the objects 
in the drawing are vertically aligned as 
necessary.  

2

If you are using standard Vectorworks plug-in 
objects, it is best to use those listed in the 
“Default Vectorworks Objects Tagged as IFC 
Objects” portion of this guide.  

Use the IFC Data command to attach IFC 
data to custom symbols and objects, so 
that they will be recognized at IFC export. 

Use the “VA Create Schedule” command to 
generate IFC schedules for default objects, 
or create your own schedules to verify and 
correct the IFC data attached to objects.  

Before exporting, set 3D Conversion 
Resolution lower to optimize the file size - 
Vectorworks Preferences > 3D > 3D 
Conversion Resolution > Low  

Select only the layers you want exported by 
using the “Export Visible Objects Only” 
option.  

Set the model to Top/Plan view before 
exporting. 

If you are exporting the model specifically 
for energy analysis, many energy analysis 
programs require a unique element called a 
1st Level Space Boundary - File > Export > 
Export IFC Project > Add-on Views > 1st 
Level Space Boundaries 

Test the quality of the IFC export file by 
verifying it in an IFC model browser. Almost 
all IFC browsers can view and validate the 
model. Some examples of IFC browsers 

3

available at this time include: 

Solibri Model Viewer (Macintosh or 
Windows) 

FZKViewer (Windows) 
DDS-CAD Viewer (Windows) 
Tekla BIMsight (Windows) 
Constructivity Model Viewer (Windows) 
RDF IFC Viewer (Windows, Macintosh 
and Linux versions planned) 

Field3D (iOS) 
IFC WebServer (web browser) 
xBIM Xplorer (Windows)  
IfcPlusPlus (Windows) 

For more information regarding IFC viewers and 
other IFC-compatible applications, visit the
buildingSMART IFC-Compatible Implementations 
Database or IfcWiki.org websites. 
 

Vectorworks project files can be exported to .ifc, 
.ifczip, and .ifcxml formats. 

Export to IFC Versions 2x2 or 2x3 is supported, 
but version 2x3 is most commonly used in 
current practice. The export of a project to an 
IFC file is based on specifying the geometry 
and associated data needed for the use of the 
exported file. This specification is called a 
Model View Definition (MVD). Vectorworks 
software supports the use of MVDs to automate 
the export, or allows the user to manually 
define a custom set of geometry and data to be 
exported. 
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To export a Vectorworks file to IFC 

Select File > Export > Export IFC Project. 

The Export IFC Project dialog box opens 
(Figure 17). Under the “Data” tab, you’ll see a 
number of options for specifying the export 
options as well as the overall project 
information such as project data, author 
data, site data, and building data. Any 
required field within this tab will be 
automatically filled based on the existing 
Vectorworks project information.  

For “Export Options,” select IFC version 2x3 
(the default) and the “CV 2.0 – Architecture” 
Model View (also a default). This particular 
Model View is an official buildingSMART 
international view for exporting 
architectural models for coordination with 
structural and MEP models.  

If you have created any “custom property 
sets,” make sure that the “Export Custom 
Property Sets” box is checked (this should 
also be checked by default). 

To better understand all the parameters 
within the “Data” tab of the dialog, please 
visit Vectorworks 2016 Help online. 
 

Click the “Layer Mapping” tab to specify 
which layers to export, and the Story Name 
to assign to them at export (Figure 18). If a 
site model is set to a “site layer” and has 

Figure 17 – IFC Project Export window – Data tab. 

Figure 18 – IFC Project Export window – Layer 
Mapping tab. 
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been tagged for IFC, it will also be 
included.  

For a project initially set up with stories, 
mapping is done automatically so that the
layers assigned to the building stories are 
automatically included in the “Mapped 
Layers” list and are mapped to an
appropriately named story. Mapping can 
also be controlled manually. 

Specify the associated building or site data for 
each of the mapped layers.  

To better understand all the parameters 
within this tab of the dialog, please visit 
Vectorworks 2016 Help online. 
 
Click OK to export the project. 

Indicate the file name and location in the 
Save As dialog box.  
 
 

Importing IFC Files 

An IFC project, including one containing 
multiple buildings or large information sets, can 
be imported into a Vectorworks file. The units 
of the imported file are determined by the 
Vectorworks file settings. An important thing to 
understand is that the files original presentation 
layers or CAD layers from an imported IFC file 
are assigned to corresponding Vectorworks 
classes. Also, the “Import IFC command” 
automatically assigns IFC building stories to 
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their own design layers. 

 

To import an IFC file: 

Select File > Import > Import IFC. 

Select the .ifc, .ifczip, or .ifcxml file to open, 
and click Open. The IFC import can be 
filtered based on elements or stories. 

Alternatively, click the file to import and drag 
it into a window where a Vectorworks 
document is open. 

 

 
  

 
 
 
 
 
Reference Model Workflow 
When considering the reference model 
workflow, think of the process as a “one way” 
data exchange.  This means that your model, 
when exported via IFC, will be received by your 
consultants and used as base information. The 
IFC file should not be used with the expectation 
that upon receipt, the model can be edited and 
manipulated as objects created natively within 
your software. Instead, the IFC models will be 
used in a file-sharing environment called the 
Reference Model Workflow. 
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In a Reference Model workflow, IFC models 
generated by the various consultants are 
collected by the project BIM manager who 
creates a federated model within an IFC browser 
application such as Solibri Model Checker for 
the purposes of clash detection, model 
validation, quantity takeoffs, and other necessary 
tasks. Once a model is validated within the IFC 
browser, it is shared among the consultants with 
relevant comments regarding the model. The 
consultants will then reference the validated IFC 
model into their own application to make the 
necessary additions and edits to their model. 
 
This workflow helps facilitate an iterative process 
involving discussion and exchange between all 
project participants. It also addresses questions 
about model ownership and responsibility by 
eliminating the possibility of editing parts of the 
model that you are not responsible for. 
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There are multiple places online to access 
more detailed information regarding IFC and 
BuildingSMART International, the entity that 
oversees IFC. 

You can visit the IFC Wiki page here.   

You can also access a full list of the different 
software that are IFC certified by 
BuildingSMART here.  
 
Information regarding Model View Definitions 
and the standardization of Exchange 
Requirements by buildingSMART can be found 
here.

 

OTHER RESOURCES AND 
INFORMATION  
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IFC – Industry Foundation Classes is a platform 
neutral, open file format that is not controlled by 
a single software vendor or a group of vendors. 
It is an object-based file format with a data 
model developed by buildingSMART to facilitate 
interoperability in the AEC industry. It is a 
commonly used collaboration format in BIM 
based projects. 
 
Open Source File Format – a format whose 
technology is freely available to the public for 
development. 
 
Standardized File Format – a format that follows 
a standard way that information is encoded for 
storage in a computer file. It specifies how bits 
are used to encode information in a digital 
storage medium.   
 
Semantic Object – a representation of a 
collection of attributes that describe an 
identifiable object. This means that the model 
describes the meaning of instance. The support 
of semantic objects is what makes IFC ideal for 
an open BIM exchange.  

 
Extensibility – a design or coding principle that 
takes future growth into consideration. 
Extensions can be through the addition of new 
information or through modification of existing 
functionality. IFC is an extensible file format in 
that new information can be added to existing 

TERMINOLOGY  
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information or existing information can be 
modified.  

 
Dynamically Extensible – the principle of being 
able to dynamically change or load in new 
information without changing the existing 
information. Adding new IFC information to an 
existing Record Format is a good example of 
this.  
 
IFC Object Tag – a label or tag that helps 
identify an IFC object.  
 
IFC Object Type – an object that has been 
identified as building element with the 
corresponding IFC tag. 
 
Property Set – attributes that define a particular 
type of object. IFCPropertySet are a collection of 
predefined attributes that are used to define an 
object. Property Sets are also referred to as 
“PSets.” 
 
Custom Property Set – user created/defined 
property sets.  
 
Model View Definition (MVD) – also called an 
IFC View Definition, a Model View Definition 
defines the IFC information needed to satisfy any 
of the Exchange Requirements defined by 
buildingSMART for collaboration. 

	
  


